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The LuckySam Main Dialog 
The figure below shows how LuckySam looks when it first starts up.  We’ll 
explain each section using the label names that appear in the figure. 
 

 
 

Menu Bar 

The Menu Bar offers these top-level menu items 

• File 

• Tickets 

• About 
These menu items are detailed in the subsections below. 
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File Menu 

Click on the File menu item, and you’ll see the File menu.  It consists of the 
options 

• Open… 

• Save… 

• Print 
The Save… and Print options are disabled whenever the Results Display does 
not show results that match the current setup and numbers. 

File / Open… 

Select the File / Open… option to re-open a previously saved game (setup, 
numbers, and results).  You’ll see an Open dialog.  Any previously saved games 
should appear with a file extension of .ls2, and this will be the default file type for 
the dialog.  Just select and open the saved file of your choice. 

File / Save… 

After you have generated your tickets to play, and results appear in the Results 
Display, you can save your results.  Select the File / Save… option, and you’ll 
see a Save As dialog.  Enter a filename you want to use to remember this game, 
and click Save.  You can open this game again in the future by using the File / 
Open… option.   
 
Note: if you want to check your results after the actual numbers have been 
picked, you must save your results (or leave them on the screen, which may not 
be so convenient). 

File / Print 

To print your results, select the File / Print option.  The contents of the Results 
Display will be printed on your default printer.  LuckySam has no Print Setup 
option, so make sure that your default printer is properly selected before using 
the File / Print option. 

Tickets Menu 

Click on the Tickets menu item, and you’ll see the Tickets menu.  It consists of 
the following options 

• Play 

• Check Wins 
The Play option is disabled whenever the setup and numbers are not properly 
set.  Once all setup is complete, the Play option is enabled. 
The Check Wins option is disabled whenever the Results Display does not show 
results that match the current setup and numbers. 

Tickets / Play 

The Play option on the Tickets menu does the same thing as the Play button on 
the main dialog.  See Play Button. 



Tickets / Check Wins 

After the actual numbers have been picked, you can use LuckySam to show you 
how well you did.  First, you have to open the results for the game you want to 
check.  See File / Open…. 
 
When you can see your own tickets in the Display Window, click Check Wins on 
the Tickets menu.  You will see the following dialog pop up. 
 

 
 
The number of spaces under Enter winning numbers and Extra Number will 
depend on your game setup. 
 
Enter the actual numbers that were selected for your game.   Once all numbers 
are entered, the OK button will be enabled.   
 
Click OK, and the Results Display will now show only your selected numbers in 
each ticket, with other numbers appearing as ‘--'.  This should make it easier for 
you to identify your winning tickets.  The picture below shows an example of how 
this looks. 
 



 
 

About Menu 

Click on the About menu item, and you’ll see the About menu.  It consists of the 
following options 

• Help 

• About LuckySam 
 

About / Help 

Click the About option on the Help menu, and a web browser will open the latest 
instruction manual (this file). 
 
Note: your computer must be connected to the internet for the Help option to 
work. 

About / About LuckySam 

Click the About LuckySam option on the About menu, and you will see a pop up 
similar to the following. 
 



 
 

The version number will show the version of LuckySam that you are running.   
 
If you are not sure you have the latest version, you can click the link on the dialog 
that says “Click Here for FREE Upgrade.”  That will open a web browser and go 
to the LuckySam download page, which will tell you the latest available version.  
As an owner of LuckySam, you are always entitled to a copy of the latest version, 
and you can download your own upgrade from here. 
 
Note: your computer must be connected to the internet for the free upgrade link 
to work. 
 

Main Numbers Setup Area 

The Main Numbers Setup Area is where you prepare to wheel most of your 
numbers.  This section is used for every kind of game, whether or not it has an 
extra number (“power” or “mega” or whatever). 

Numbers Per Game 

Click on the up and down arrows to set up for a game with 3, 4, 5, 6, or 7 main 
numbers.  Do not include any extra number (“power” or “mega” or whatever) in 
this value. 

From and To 

These two entries define the range of numbers that can be picked in the main 
part of the game.   
 
The entry after From is the smallest value of all numbers that can be picked in 
your game.  For normal lottery games this is always 1, but LuckySam lets you 
change this anyway, in case you want to experiment. 
 
The entry after To is the greatest value of numbers that can be picked in your 
game.  This is different for every lottery game, so be sure to check your rules. 
 
Based on your game’s rules, enter the values of the smallest and greatest 
numbers in the main part of your game in the From and To entries. 



Numbers To Wheel 

Click on the up and down arrows to set how many different numbers you want to 
wheel when picking your tickets to play.   
 
The Numbers To Wheel value always has to be at least as great as the Numbers 
Per Game value.  If there are five main numbers in your game, you must wheel 
at least five numbers. 
 
You can wheel up to 40 numbers with LuckySam.  Actually, that depends on 
the rules of your lottery game.  If the From and To are set for a game with only 30 
numbers (From 1 To 30), then you can only wheel up to 30 numbers, 1 through 
30. 
 
Note:  We recommend that you set From and To before you set your Numbers 
To Wheel, and before you enter the numbers themselves.  LuckySam will 
automatically change your Numbers to Wheel, and delete any unused numbers,  
to make sure that Numbers to Wheel is no greater than (To – From + 1).  If you 
change the From or To entries after you set Numbers to Wheel, you may have to 
re-do your other settings. 
 

Random Button 

If you don’t have special or favorite numbers you want to play, just click the 
Random button.  LuckySam will automatically fill your Main Numbers To Wheel 
with a random selection.  Every time you click Random you will get a new 
random selection.  Keep clicking until you see a set you like. 
 
Note: you can change any number yourself, even after you click the Random 
button.  For example, if you only have one favorite number, you can use the 
Random button to pick the rest, and then change one of the random picks to your 
favorite number. 

Main Numbers To Wheel 

These entries are where you enter the numbers that you want to wheel in the 
main part of your game.  If you have a favorite set of numbers, type them into 
these spaces. 
 
You can also use the Random button to fill these spaces with a random selection 
of numbers in the range From to To.  Then, if you want, you can change any of 
the numbers by just selecting the entry, and typing your number. 
 
Note: if you enter your own numbers, you should not enter duplicate values.  
LuckySam will not check this for you because you might want to experiment, to 
see what happens if you do enter duplicates.  If you do, some of your tickets in 
the Results Display may have duplicate numbers, so remember, we warned you! 
 



Note: you can also enter numbers that are outside of the From and To range.  
This does not make much sense to do, unless you are experimenting with the 
From or To entries.  We want to let you experiment if you like, so LuckySam will 
not force all your Numbers To Wheel to be between From and To.  Just be sure 
to double check your entries. 

Main Numbers Combos 

LuckySam shows you the number of unique combinations (how many different 
tickets) are possible for your setup.  This is determined from the Numbers per 
Game and the Numbers to Wheel.  You cannot edit this number, it is computed 
automatically.  It’s just there to give you some idea of your wheel’s coverage.  It 
also tells you the maximum number of tickets you can generate with LuckySam.   

Extra Number Check Box 

If your lottery game has an extra number (“power” or “mega” or whatever), then 
check this box to enable the Extra Number Setup Area below. 

Extra Number Setup Area 

The Extra Number Setup Area is where you prepare to pick your extra numbers.   
LuckySam supports games that have one extra number. 
 

From and To 

These two entries define the range of numbers that can be picked in the extra 
number.   
 
The entry after From is the smallest value of all extra numbers.  For normal 
lottery games this is always 1, but LuckySam lets you change this anyway, in 
case you want to experiment. 
 
The entry after To is the greatest value of all extra numbers in your game.  This 
is different for every lottery game, so be sure to check your rules. 
 
Based on your game’s rules, enter the values of the smallest and greatest extra 
numbers in your game in the From and To entries. 
 

Extra Numbers To Wheel 

Click on the up and down arrows to set how many different numbers you want to 
use as extra numbers on your tickets.   
 
If you checked the Extra Number Check Box, you must wheel at least one 
number. 
 



You can wheel up to 40 extra numbers with LuckySam.  Actually, that 
depends on the rules of your lottery game.  If the From and To are set for a game 
with only 30 numbers (From 1 To 30), then you can only wheel up to 30 extra 
numbers, 1 through 30. 
 
Note:  We recommend that you set From and To before you set your Extra 
Numbers To Wheel, and before you enter the numbers themselves.  LuckySam 
will automatically change your Extra Numbers to Wheel, and delete any unused 
numbers,  to make sure that Extra Numbers to Wheel is no greater than (To – 
From + 1).  If you change the From or To entries after you set Extra Numbers to 
Wheel, you may have to re-do your other settings. 
 

Random Button 

If you don’t have special or favorite numbers you want to play, just click the 
Random button.  LuckySam will automatically fill your Extra Numbers To Wheel 
with a random selection.  Every time you click Random you will get a new 
random selection.  Keep clicking until you see a set you like. 
 
Note: you can change any number yourself, even after you click the Random 
button.  For example, if you only have one favorite number, you can use the 
Random button to pick the rest, and then change one of the random picks to your 
favorite number. 
 

Extra Numbers To Wheel 

These entries are where you enter the numbers that you want to use as extra 
numbers.  If you have a favorite set of numbers, type them into these spaces. 
 
You can also use the Random button to fill these spaces with a random selection 
of numbers in the range From to To.  Then, if you want, you can change any of 
the numbers by just selecting the entry, and typing your number. 
 
Note: you can enter numbers that are outside of the From and To range.  This 
does not make much sense to do, unless you are experimenting with the From or 
To entries.  We want to let you experiment if you like, so LuckySam will not force 
all your Extra Numbers To Wheel to be between From and To.  Just be sure to 
double check your entries. 
 

Total Combos 

As you change your setup, LuckySam computes how many unique combinations 
of numbers your setup will give.  This number is the greatest number of tickets 
that you can generate with your setup. 



Number of Tickets to Generate 

Enter the number of tickets you want to buy here.  After you click Play, the 
Results Display will show this many unique number combinations. 

Play Button 

When you click Play, LuckySam computes the wheel you described in your 
setup, and show the tickets you should play in the Results Display.  There is 
nothing random about this… these tickets will be the most evenly distributed 
combinations of your Numbers to Wheel that are possible.  If you click Play again 
for the same setup, you will get the same results every time.  If you want to play 
different tickets, you will have to change something in your setup! 

Buy Lottery Tickets Online 

Click the image, and a browser window opens to a site where you can purchase 
lottery tickets from around the world.  For local games you’ll do better at your 
local convenience store (just sayin’).  But if you want to purchase tickets from 
another state or another country, and if it is legal in your area, this is the place to 
go! 

Status Bar 

The Status Bar updates to show you LuckySam’s view of the world.  If you think 
something isn’t working, check here.  You may find your answer. 
 


